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Semester 2, 2000

Some Exercises on Microsoft Access

Some Terms:

Table:

A collection of data about a particular subject. In relational database,                       this data is presented in columns(attributes or fields) and rows (records)

Query:

Brings requested information together to satisfy a question. The resulting                set of rows is called a dynaset.

Control:

An object on a form or report which displays data from an attribute,                           results of a calculation, a graph, picture or other object.

Form:

An object which can be used to enter, alter and view rows on a screen or                 in printed form.

Report:

An object used to present information in a custom layout. Multi levels of                    totals are normally associated with a report.

Macro:

A list of functions which will execute when called. Normally a group of                      regularly used functions.

Module:

A collection of procedures which are built using the programming                              language.

Object:

A unit e.g. table, form, report, control which can be selected and used as                  a unit. 

Some Functions:
1. Opening a database
             Start Access.


  Choose Open Database from the File menu. 

             Select the required database from the File Name

             List box.

             Choose the OK button.

2. The Database Window.


   Menu Bar - includes menus and commands used to create and use                         

              objects.


  Tool Bar - range of options for common operations and for obtaining help


  Object Buttons - provide direct access to every object in the database

3. Viewing Data and Closing a Database.

              In the database window, click the Table button.

              Double click the name of the table you wish to see.

             To return to the database Window, click it.

Note: Fields can be resized and rearranged as with a spreadsheet.                                    

          Horizontal and vertical scrolling is also available.

To run a Query, click the Query button in the database Window, and double click 

 the Query required.

To View data using a Form: Click the Form button  in the database window.

Double click on the Form required.

To display a Form in Datasheet view, click the Datasheet View button on                 the tool bar.

4. Close a Database.

Switch to the Database window

From the File menu, choose Close Database

5. Creating a New Database


    Choose New Database from the File menu

               Enter your database name selected in the File Name box

If you are going to store the database in a  different directory, use the                                          

Directories list  to nominate your choice

If you wish to change drives, use the Drives list.  After completing the New               

Database dialog box, click OK

The next step is to set up the object (table) structure within your database.                After this is completed, you will be able to create other objects  (Query,                                          Form, Report).

6. Create and Modify an Object

              Create : Click the Object button indicating the type of object (table,                                          

               query, form, report..)

                            Choose the New button.

               For modify, click the object you require, then click  the Design button      

               Follow the prompts

7. To Create a table


 Start Access and open the appropriate database  The term ‘tables' will                                 

             appear in the database window

             Choose the New button ( i.e. New Table)

 
  Enter data as appropriate in the various columns, including Description

             Field name defines the field

             Data type defines the type of data for the field

             To move from box to box, press TAB

  Some data types are default. To access the data types list, click the     

  arrow  to open the list, or use the first two characters of the data type in   

  the appropriate field.   e.g. for a Currency datatype, type   'cu'.                


   Cue Cards.


   Use the Cue Cards from the Help menu to assist you with your tasks


   On Line Help.

             Click on the large Question Mark on the toolbar

             Choose Search and supply the first 3 (min) characters of the topic you                                    

             require.

             Double click a keyword related to your subject

             The F1 key is also a good entry point to Help


Today’s Working Exercise
You are going to create a small customer database using Access.


The structure of the database is

           First name : character: 10 bytes 

           Last name  : character: 15 bytes

           Address : character : 30 bytes

           Customer Account Code : numeric : 6 bytes (must be > 500 and <   

            599999)

           Date of Birth : date (must be > system date)    [> date()]

           Invoice Number : numeric : 4 bytes

           Invoice Amount : money : profile $9999.99

           Invoice date : date

You will notice that there are some constraints placed over actual values of data which the table can accept. For instance the Customer Account codes must be in the range 501 to 599998. This is a property constraint and is entered in the 

‘Validation Rule’ box. In this case the ‘Rule’ is >500 and <599999

Once you have created this structure, and indicated the primary key by                     

highlighting the attribute and dragging the Key icon to it, populate it with some         representative data. For multiple keys, hold down the Shift Key while dragging.

Develop 10 records with varying Invoice dates and amounts.   

Now perform these tasks:

(1) Find which customers have Invoice amounts in the range $20.00 to                          

       $500.00

 (2)  List all customers - Last Name, Address, Account Code

These are probably commonly recurring outputs required from the database tables.

You should create queries and Name them (not query1 but Invoice Analysis ….)

Access Exercise  2

The preliminary exercise introduced you to creating a table with some constraints (conditions which control values in the table(s) or which control the processing of  values in the tables(s))  and you developed a query – which gave a limited set of output, either with or without calculations.

The more common use of relational databases is to associate data in many tables in a database using a number of techniques,  the referential Foreign/Primary key being at the top of the list.

In this exercise, you will create and populate 3 tables, with constraints, and use the dialog boxes and prompts to allow you to select required information as the output of a query.

The three tables are

1. Employee(Employee Number, Date Hired, Last Name, First Name, Date of Birth, Street/Road Address and Suburb, PostCode, Gender

2. Position(Employee Number, Store Name, Department, Job Title

3. Payrate(Employee Number, Hourly Rate)

From this you can deduce that you are setting up a small database about people who are employed in a Store(for example Myer), where there are a number of Departments (Books, Shoes, Perfumes, Clothing …)

You  might examine the Primary-Foreign keys in the above table schemas. What are they ? Are they practical ? Can they be constrained ?  As you spend some time on this exercise you will build up the conditions which suit the database profile, or more importantly, suit the Business case.

In creating the tables, you will need to allocate a datatype and size to each attribute. (50 bytes for a name is too many bytes)

When selecting datatypes, be explicit. For instance - an Employee Number. Is that a real arithmetic type number or is it a general term meaning Identification ? Is it a number such as 34895,  or P261 ?    It’s your choice. Whatever you select, the datatype must give you the degree of conformity you expect. So,  be precise.

In creating the structure, you must work with both the  Field Names and Datatypes AND the properties (in the lower box) which you will assign to the fields again based on your understanding of the business case. Use the pull down options boxes.

In the case of the table ‘Employee’ these properties could be assigned to the

 ‘Employee Number’ ;

Date Type : number


Field Size :  single




Decimal places : 0

Validation Rule : > 100

Required  : yes

This means that the Employee number set must be ‘single’ length (use the help to follow this up), there are NO decimal places allowed in the real data values, the number set must not contain any value less than 101, and the Employee Number is Required – there must be a value in every row. 

Each attribute will have its own set of ‘properties’

Every Primary Key must be set to Required and must be unique (not duplicated). 

The Primary Key is assigned by highlighting the appropriate attribute and then clicking the ‘key’ symbol. For a multiple key, hold down the Shift key.

When you have created the all of the table structures, you will need to populate them. This needs care as the data in the various tables must be able to be related through the Primary-Foreign key values..Create 5 rows in each table.

Now, onto the development of a query  (or two):

1. Use Tools, Relationships to create the association between your 3 tables. This is done by associating the Primary Key in one table with the Foreign key in the joining table. Drag the pointer to the selected key.

2. Return to the main menu and select ‘Queries’. This should bring up a dialog panel with ‘New’ (meaning a new query is about to be developed) and you will also see the terms ‘open’ and ‘design’ – more about that later.

3. Select the ‘new’ option and from the dialog box which appears, select Design View.

Select the tables which will take part in your query, and ADD them. When you have finished selecting the tables, close the ‘Show table’ dialog box and then start selecting the attributes names into the field boxes on the query properties dialog box. You will probably select :

Employee Number, Last Name, First Name, Date Hired, Store, Department, Hourly rate – in that order.

You will need to select the appropriate attributes from the tables where the data exists.  Drag the attribute name to the ‘Field’ column of the panel.  Take your time and when you have selected all of the attributes, click on the top left hand button on the Query development box and call the query ‘Employee Query’.

4. You should now have a query named ‘Employee Query’. Run it by highlighting  

      ‘Open’  Are the results what you expected ?

5. Now create another query which will allow the analysis of data with the criteria that the ‘Date Hired’ is after the 12th December, 1988.     To develop this,  follow the procedure as above, select only those attributes which are relevant to the query, and  in the ‘Date Hired’ field, use the criteria setting to insert 12/12/1988.   Close the query development, call the query ‘Date Analysis’ and run the query.  This date can be altered in the Design mode for any other data based query – but be careful. When the query is run it will use the current embedded date, so the user must be aware what the date set is – if not, then there could be confusion or error in using the query output.

6. Finally, to round off this exercise, develop a query to show the names of those people who work in a nominated store (your choice).  Run the query.   Amend the query to show more than one store by amending the criteria to include another store using the Or function:  for example if your selected store was Chadstone and you wanted to include another store (Highpoint), then the criteria would initially look like ‘Chadstone’ or ‘Highpoint’  NOT Chadstone AND highpoint as a person can work only in one store at any one time. 

